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Requirements and Compatibility

« Requirements (page 1)

« Signature Agent (page 1)

« Schedule (page 1)

« Common Language Runtime (page 1)
« Compeatibility (page 1)

« Signature (page 2)

« Transfer Layer Security (TLS) (page 2)

Requirements

Event trigger notifications are set up within two applications:

Signature Agent
See Completing Signature Agent Configuration (page 5) for additional information.

» For standard communication, Signature Agent contains the event notification setup.
» For advanced communication, Signature Agent contains the company information including the logos and
accent color for the HTML email.

Schedule
In Schedule, see Setting up Technicians in Schedule (page 23).

« For standard communication, Schedule contains the technician information including the technician/customer
email address.

« For advanced communication, Schedule contains the technician information including the technician's position,
email address, and photo that is included in the HTML email.

Common Language Runtime

NET Framework Common Language Runtime (CLR) must be enabled in SQL Server.
To enable this, in SQL Server run this command:

EXEC sp_configure 'clr enabled', 1;

RECONFIGURE WITH OVERRIDE;

Compatibility

Signature Agent 2.5 is compatible with the following.
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Signature

+ Schedule 4.7 or higher
+ 2018 R7 (18.05b07)
+ 2018 R6 (18.04b06)

Transfer Layer Security (TLS)

Server Protocols
« TLS1.2

Client Protocols

o TLS 1.0 (currently required)
« TLS1.1
« TLS1.2

Copy of Requirements and Compatibility

« Requirements (page2)
« Signature Agent (page 2)
« Schedule (page 2)
« Compatibility (page 3)
« Signature (page 3)
« Transfer Layer Security (TLS) (page 3)

Requirements

Event trigger notifications are set up within two applications:

Signature Agent
See Completing Signature Agent Configuration (page 5) for additional information.

« For standard communication, Signature Agent contains the event notification setup.
« Foradvanced communication, Signature Agent contains the company information including the logos and
accent color for the HTML email.

Schedule
In Schedule, see Setting up Technicians in Schedule (page 23).

+ For standard communication, Schedule contains the technician information including the technician/customer
email address.
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« For advanced communication, Schedule contains the technician information including the technician's position,
email address, and photo that is included in the HTML email.

Compatibility

Signature Agent 2.5 is compatible with the following.

Signature

+ Schedule 4.7 or higher
+ 2018 18.04b06

+ 2018 18.03b05

+ 2018R3

Transfer Layer Security (TLS)

Server Protocols
« TLS1.2

Client Protocols
« TLS1.2

Installing Signature Agent Configuration

1. Right-click Signature Agent 2.x.x.exe and select Run as administrator.

2. If prompted with the User Account Control window, select Yes to allow the program to make changes to the
computer.

3. Onthe Welcome to the Signature Agent Setup Wizard window, select Next.

4. Onthe End-User License Agreement window, review and accept the terms of the license agreement, and then
select Next.

5. On the Select Installation Folder window, accept the default installation location C:\Program Files
(x86)\Signature\Signature Agent or use the Browse button to select a different installation location, and then
select Next.

6. On the Ready to Install window, select Install.

7. Onthe Completing the Signature Agent Setup Wizard window, select Finish.

& fthestandard event trigger and Advanced Comm trigger emails are not reflecting the correct time, this can fix
this by launching Signature. Then go to Microsoft Dynamics GP > Tools > Settings > Service Management >
Module Setup > Setup Options. In the Setup Options window, click OK.

This is happening because the appointmentview relies on the K2ACDC.setupoption record to exist in the
K2ACDC.setupoption table. This table contains the Time Zone View setting so if the record is not there, it
reverts to TZV=False. By performing the step above of launching the Setup Option window and clicking OK
creates a record in the table and then the email times will be reflected accurately.
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Upgrading Signature Agent Configuration

© IMPORTANT

Prior to upgrading

« Do not uninstall your previous version of Signature Agent before upgrading as data from the original
installation is used. The previous version can be uninstalled after upgrading.

« Document any additional CDC Configuration triggers that have been enabled as these may be disabled
after upgrading.

Upgrading Signature Agent

1. Right-click Signature Agent 2.x.x.exe and select Run as administrator.

2. If prompted with the User Account Control window, select Yes to allow the program to make changes to the
computer.

3. Onthe Welcome to the Signature Agent Setup Wizard window, select Next.

4. Onthe End-User License Agreement window, review and accept the terms of the license agreement, and then
select Next.

5. On the Select Installation Folder window, accept the default installation location C:\Program Files
(x86)\Signature\Signature Agent or use the Browse button to select a different installation location, and then
select Next.

6. Onthe Ready to Install window, select Install.

7. Onthe Completing the Signature Agent Setup Wizard window, select Finish.

& 'fthestandard event trigger and Advanced Comm trigger emails are not reflecting the correct time, this can fix
this by launching Signature. Then go to Microsoft Dynamics GP > Tools > Settings > Service Management >
Module Setup > Setup Options. In the Setup Options window, click OK.

This is happening because the appointmentview relies on the K2ACDC.setupoption record to exist in the
K2ACDC.setupoption table. This table contains the Time Zone View setting so if the record is not there, it
reverts to TZV=False. By performing the step above of launching the Setup Option window and clicking OK
creates a record in the table and then the email times will be reflected accurately.

After Completing the Upgrade Steps

+ Uninstall the Previous Version of Signature Agent (page 5)
« Uninstall/Install Service in Signature Agent (page 5)
« Verify Trigger Status (page 5)
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Uninstall the Previous Version of Signature Agent

When upgrading to Signature Agent 2.x.x from a previous version, you will need to uninstall the previous version using
Windows Add/Remove Programs.

Uninstall/Install Service in Signature Agent
In Signature Agent, you will need to uninstall and then reinstall the service for each company.

1. Launch Signature Agent Configuration.

From the button bar, select Uninstall Service.
Select OK in the Success pop-up window.
Select Install Service.

Select OK in the Success pop-up window.

abrwn

Verify Trigger Status

1. InSignature Agent, on the Home tab, expand each company.
2. Select either Event Triggers or Advanced Comm Triggers to view the triggers.
3. Verify that the triggers that were enabled prior to upgrading are still enabled.

Completing Signature Agent Configuration

Launch Signature Agent Configuration

This is the user interface that is used to configure the CDC and Event triggers.

1. Launch Signature Agent Configuration.
2. Onthe Login window, enter the following information:
« SQL Instance
+ Authentication
« Login
+ Password
3. Select Login.
4. The Signature Agent Configuration is divided into two tabbed sections:
+ Home: The Home tab is where Signature Agent is configured.
+ CDC Configuration: The CDC tab is used to set up the CDC for the database for capturing state changes
to the database tables.

Set up Change Data Capture (CDC) Configuration

Create the CDC change options on the CDC Configuration tab.

1. In Signature Agent Configuration, select the CDC Configuration tab.

2. Inthe Name column, expand the Dynamics GP database.

3. Select the company database.

4. Select Create Objects to create the CDC change options that are listed on the right side of the window.



5.

6.
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The following entities are available:
« Appointment
« Equipment
» GP Customer
« Job
« Job Cost Code
« Location
+ Service Call
« Service Option
« Technician

To enable an entity, select the entity name and then select Start from the menu bar. For example, enable

Job to track changes to the job tables for job appointments. To disable an entity, select 0 Stop from the
menu bar.

« Enabled entities are indicated with a green Q icon.

+ Disabled entities are indicated with a red o icon.

Configure Signature Agent

Each company that will be used with Signature Agent Configuration will need to be set up by associating the company
to a Signature Agent Service that will be monitored for changes.

1. Onthe Home tab, create a new company by choosing New Company or select an existing company.
2. From the menu bar, select Properties.
3. Inthe Edit Company Connection window, complete the following tabs:
» Database
+ Access
» Company Info
« Advanced Comm - This tab only displays if you have purchased Advanced Communications.
» Dispatcher Email
+ Maintenance
4. Afteryou select the OK button to save changes made to any of the tabs in the Edit Company Connection window,
you will need to restart the Service. A pop-up window displays to remind you to complete this step. You can do
this by selecting the Restart button from the button bar is Signature Agent or in the Properties window by
selecting the Agent Service drop-down and then select Restart Service.
A Select OKon each tab to save changes.
Database Tab
Enter the company database settings.
1. Select the Database tab.
2. Enter the Company Name. This is only used for the display name in the Tenant tree to the left.
3. Enter the Database Name or select Browse and then select the company database.
4. Enterthe database Username and Password.
5. Select Test Connection to verify that the database settings are correct and can connect to the database. You will
be prompted to save the settings prior to the test running.
6. The Access Key is generated at this time and can be found on the Access tab.
7. Select OK.
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Access Tab

Enter the Email Alias to create the email address that your customers will use when sending an email to create a service
call. This email alias is also used as the "Sender" when sending communications to your customers and technicians. For
example, if you create an alias of Fabrikam, your customers would send an email for a service

to fabrikam@servicerequests.io.

Select the Access tab.

Select Show to view the Incoming Access Key and the API Key.

« The Incoming Access Key is generated by the database once the company is saved prior to testing the
configuration. This key is used as a unique identifier.
« The API Key is automatically generated from WennSoft.

Enter the Email Alias.

4. You can select the Agent Service drop-down to perform the following service options. These options are also
available from the menu bar on the Home tab. Customer Support may direct you to perform these steps during
troubleshooting.

+ Install Service

+ Uninstall Service

+ Reinstall Service

+ Restart Service
5. Select OK.

N

w

Company Info Tab

1. Select the Company Info tab.
2. Enter the company information that can be included in some of the communications to your customers.
« Company Name
« Company URL
+ Address
« City
« State
. Zip
+ Phone Number
« Email
3. Select OK.

Advanced Comm Tab

1. Select the Advanced Comm tab.
2. Complete the following fields:
+ Header Logo: Select Upload and then navigate to the location of your logo and select OK. The maximum
width for the logo is 185 pixels.
+ Select Preview to view the logo.
+ Select Delete to remove the logo.
« Footer Logo: Select Upload and then navigate to the location of your logo and select OK. The maximum
width for the logo is 185 pixels.
+ Select Preview to view the logo.
+ Select Delete to remove the logo.

1 mailto:fabrikam@servicerequests.io.
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+ Accent Color: Select the Accent Color drop-down. You can select between Custom, Web, or System tabs
for choosing or entering the color that will display at the top and bottom of the email.
3. Select OK.

Dispatcher Emails Tab

This section is used for selecting which email addresses to receive service call updates. The email addresses displayed
are set up in the User Roles section of Schedule Administrator Settings. See Working with Roles? in the Schedule User
Guide.

1. Select the Dispatcher Emails tab.
2. Mark the email address checkbox(es) to indicate where notifications of service call updates should be sent.
3. Select OK.

Maintenance Tab

This section is used for setting up a Maintenance Schedule. The Next Scheduled Eventing Pause is used to stop
Signature Agent from accessing the database. This allows you to perform database maintenance without
generating CDC records that might generate communications.

1. Select the Maintenance tab.
2. Select Edit.
3. Inthe Eventing Schedule Editor window, create an optional schedule to pause the Eventing Engine.
a. Select Weekly or Monthly.
+ Weekly - Select the day(s).
« Monthly - Select the day number and the frequency.
b. Select the Time of Day and Frequency.
c. Enter the Duration (Hours).
4. Select Preview to view what the next 10 occurrences would be based on the setup. Select OK to return to the
Eventing Schedule Editor.
5. Select OK. The Tenant tree now displays the company and automatically creates Event Triggers.

View the Log File

Select View Event Log from the menu bar to view the log.txt file that displays information about trigger events and also
denotes when issues occur. For example, an email for service was received and a response is sent out.

Optional: Remove JOIN to Table SV000805

Some users have experienced a query timeout with the JOIN to the SV000805 (Note) table. By eliminating this JOIN,
query performance is significantly improved from taking minutes to run to now only seconds.

If you are not using the Service_Desc_Note field (long note description) when defining standard or advanced
communication event emails, we recommend that you manually set "ExcludeNotes" to "true" to remove the JOIN.

To remove the JOIN to table SV000805:

1. Goto C:\Program Files (x86)\Signature\Signature Agent.
2. Right-click on SignatureAgentService.exe.config and select Edit.

2 https://docs.key2act.io/display/SCHED46/Working+with+Roles
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3. Change the value to "true" for the following line:
<add key="ExcludeNotes" value='"false"/>
4. Save thefile.

Working with Event Trigger Notifications

The event triggers are automatically created for the company after testing the connection and are based on the CDC
table views. These notifications can be enabled or disabled based on the customer's communication requirements. You
can send the email notification in Schedule from the appointment window or by right-clicking the appointment and
then choosing Notify Customer.

& Only users with Advanced Communications (page 34) can send out HTML emails and use the Notify Customer
button in Schedule.

There are 9 default standard triggers that are created during the installation:

+ Appointment-AppointmentCanceled

+ Appointment-AppointmentCreatedAndScheduled

+ Appointment-AppointmentReassigned

+ Appointment-AppointmentRescheduled

» Appointment-AppointmentScheduled

+ Appointment-TechnicianArrived

» Appointment-TechnicianCheckedOut

« ServiceCall-ServiceCallCreated-2016+ - Email that is sent to your customer if they are using Signature 2016 or
higher when a service call is created.

« ServiceCall-ServiceCallCreatedByEmail-2016+ - Email that your customers are sent after a service call is created
from an email request from your customer.

Standard event trigger notifications are set up within two applications:

« Signature Agent Configuration contains the event notification setup. See Completing Signature Agent

Configuration (page 5).
+ Schedule contains the technician information including the technician/customer email address. For more

information, see Setting up Technicians in Schedule®.

3 https://docs.key2act.io/display/SignatureAgent24/Setting+up+Technicians+in+Schedule
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Working with Event Triggers

Editing an Existing Event Trigger

1. Toview the properties on the triggers, select an event trigger and then select Properties or double-click the
event trigger.
2. Inthe Edit Event window, the General tab displays the General Settings and Operations.
» Trigger Name: Indicates that any time a service call is created, this event will be active.
« Trigger Type: Displays a list of active CDC tables.
« Event ID: This display-only value is a concatenation of the "Trigger Type - Trigger Name".
« Operations
« Mark the operation (Delete, Insert, and/or Update) to occur in the CDC table view when the trigger
is activated. Depending on the trigger type, additional choices are available in the Operations
section.
+ Select the Watch Columns drop-down to display a multi-select list where you can select the
columns that need to be watched in the CDC table view.
» The Trigger Enabled checkbox indicates that the trigger is in use.
In the example below, the Appointment-AppointmentCancelled trigger event properties are displayed. This
trigger is set up to send an email when an appointment status is set to "Cancelled".
« The Operation is set to watch the CDC table for updates to the Appointment_Status column.

General

Trigger Criteria Trigger Name: | AppointmentCancelled
Actions Trigger Type Appointment «| [+

EventID: | Appointment-AppointmentCancelled

Delete Insert ! Update

Watch Columns: | Appointment_Status

& Trigger Enabled

OK Cancel

3. The Trigger Criteria tab is used to set up specific criteria that may need to be met for the trigger to activate. Use
the Values and Previous Values tabs and the formula buttons to create the trigger criteria. To enter the values
necessary for the formulas, select the VAL button and enter the data.

10
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For the example below, continuing to the Trigger tab for the Appointment-AppointmentCancelled trigger event,
we are looking at the Trigger Criteria. Note that all of the criteria are joined with an AND which indicates that all
three criteria must be met to activate the trigger. If a criteria is joined with an OR, this indicates that either the
previous criteria line or the following criteria line must be met.

+ The Previous Scheduled State (prev_state_scheduled) in the CDC table must be 1.

« The Appointment Status must be CANCELLED.

« The Appointment Type must be 1.

General

[prev_state_scheduled] =1

Trigger Criteria |3Nd . )
[Appointment_Status] = 'CANCELLED
and

Actions [Appointment_Type] = 1

+ -] =||E[<]||> (n) AND OR | |DATE || VAL

Values | Previous Values

Actual_Hours
ADRSCODE
Appointment
Appointment_Description
Appointment_Group_ID
Appointment_Priority
Appointment_Status
Appointment_Type
Caller Email Address

oK Cancel

4. The Actions tab displays the action properties. The initial display is what is currently out-of-the-box set up and
includes the Name and Action Type. This information is fully editable. Select New (to create a new Action)
or Edit (to edit an existing Action) to display the Action Properties window.

« Action name/Type: View or edit the action that happens when the event is triggered.

« Recipients: If additional recipients need to receive the email, enter the email address values here.
(Examples, [TechnicianEmail], [Caller_Email_Address]. The information used for the values that have
been set up in Signature.

+ Caller email address: Stored in the Service Call window [Caller_Email_Address]. If you are using a
user-defined field for the email

« Technician email address: Stored in Schedule Resources window [R_Email].

+ Send to Creator: If marked, the creator will also receive the email communication when the
trigger is creating a service call via an incoming email.

+ Subject: Displays what the email subject line will contain.

« Email Body: Displays what the body of the email displays. Different parameters can be selected by right-

clicking and then choosing currently-available values from the current record or you can select
previously-used values.
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In the example below, two emails will be sent when the Appointment-AppointmentCancelled trigger is
activated.

General
HName Action Type
Trigger Criteria | Email Email
Email Email
Actions
New Delete
oK Cancel

One email is sent to the caller's email address and the other email is sent to the technician's email
address.

ent Action

Action Properties
Action Name/Type: ||[=El Email v
Recipients: |[Caller_Email_Address]
Send To Creator

Subject: |Appointment was Cancelled

Email Body: |Appointment [Appointment] for Service Call ID -
[Sewnice_Call_ID] scheduled for [StartDateTime] has
been cancelled at your request.
Thank you,

Fabrikam Service Department

Save Cancel

12
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Edit Event Action

Action Properties

Action Name/Type: |[=nElll Email -
Recipients: |[R_Email]
Send To Creator

Subject: |Senvice Appointment Cancelled

Email Body: | Appointment [Appointment] for Service Call ID
[Sewnice_Call_ID] appointment for [StartDateTime] has
been cancelled.

Thank you,

Fabrikam Service Department

Save Cancel

5. Select Save and then select OK.

Create a New Event Trigger

1. Tocreate a new trigger on the Home view, select New Trigger Event.
2. Select the + button to the right of Trigger Type and then enter the name of the view to add.
3. Complete the remaining fields/tabs as described in Viewing/Editing event trigger properties.

Mappable Fields and Labels

The following is a list of mappable fields/labels for Current Values and Previous
Values.

« Current Values (page 13)
« Previous Values (page 18)

1N + Attachments can be included and stored
+ These are not case-sensitive
+ Spaces are optional

Current Values

Value Additional Information

Actual_Hours

ADRSCODE Location ID/Number
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Value Additional Information

Appointment

Appointment_Description

Appointment_Group_ID

Appointment_Priority

Appointment_Status

Appointment_Type

Caller_Email_Address

Caller_Name

Caller_Phone

Cancelled_Reason

Completion_Date

Cost_Code_Alias

CREATDDT Created Date
CRUSRID Created User ID
CUSTNAME Customer Name
CUSTNMBR Customer ID/Number
Description

DEX_ROW_ID

Divisions

14
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Value Additional Information

EndDateTime Ending Date/Time

ENDTIME End Time

Estimate_Hours

Labor_Override

Location_ADDRESS1

Location_CITY

Location_Contact_Person_1

Location_Phone_1

Location_STATE

Location_ZIP

LOCATNNM Location Name
MDFUSRID Modified User ID
MODIFDT Modified Date
Modified_Time

Priority_of_Call

Problem_Description

Purchase_Order

R_Email Reply To/Caller Email Address - R_Email comes from the
K2A_ResourceExtension table and is the primary email
address setup in Schedule.
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Value Additional Information

Service_Call_ID

Service_Desc_Note Service Call Description Note

Service_Description

Service_User_Defined _10

Service_User_Defined _11

Service_User_Defined _12

Service_User_Defined _18

Service_User_Defined _19

Service_User_Defined _2

Service_User_Defined _20

Service_User_Defined _21

Service_User_Defined _3

Service_User_Defined _4

Service_User_Defined _5

Service_User_Defined _6

Service_User_Defined _7

Service_User_Defined _8

Service_User_Defined _9

Service_User_Defined_1
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Value Additional Information

Skill_Level

StartDateTime Start Date/Time
State_Created

State_Scheduled

STRTTIME Start Time
SV_Tool_ID

Task_Date

Technician

Technician_Long_Name

Technician_Status

TechnicianEmail TechnicianEmail comes from the SV00115.SV_Pager_PIN
column which can be used for the technician's SMS
email gateway email address. e.g. {phone-number}
@vtext.com* for Verizon as an example.

TechnicianPhone

TechnicianSkillLevel

Time_Entered_CB Time Entered checkbox
Type_of_Call Call Type
Type_of_Problem Problem Type

UDCB1 AC Notify flag

4 http://vtext.com
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Value Additional Information

UDCB2

UPRTRXCD Payroll Transaction Code

UserDD1

UserDD2

USERDEF1

USERDEF2

USRDATO1

USRDATO02

Wennsoft_Affiliate

Wennsoft_Branch

Wennsoft_Region

WS_Cost_Code Cost Code
WS_Job_Number Job Number
Previous Values

Value Additional Information

prev_Actual_Hours

prev_ADRSCODE Previous Location ID/Number
prev_Appointment

prev_Appointment_Description
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Value Additional Information

prev_Appointment_Group_ID

prev_Appointment_Priority

prev_Appointment_Status

prev_Appointment_Type

prev_Caller_Email_Address

prev_Caller_Name

prev_Caller_Phone

prev_Cancelled_Reason

prev_Completion_Date

prev_Cost_Code_Alias

prev_ prev_CREATDDT Previous Created Date
prev_CRUSRID Previous Created User ID
prev_CUSTNAME Previous Customer Name
prev_CUSTNMBR Previous Customer ID/Number

prev_Description

prev_DEX_ROW_ID

prev_Divisions

prev_EndDateTime Previous Ending Date/Time

prev_ENDTIME Previous End Time
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Value Additional Information

Estimate_Hours

prev_Labor_Override

prev_Location_ADDRESS1

prev_Location_CITY

prev_Location_Contact_Person_1

prev_Location_Phone_1

prev_Location_STATE

prev_Location_ZIP

prev_LOCATNNM Previous Location Name
prev_MDFUSRID Previous Modified User ID
prev_MODIFDT Previous Modified Date

prev_Modified_Time

prev_Priority_of_Call

prev_Problem_Description

prev_Purchase_Order

prev_R_Email Previous Reply To/Caller Email Address - R_Email comes
from the K2A_ResourceExtension table and is the
primary email address setup in Schedule.

prev_Service_Call_ID

prev_Service_Desc_Note Previous Service Call Description Note
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Value Additional Information

prev_Service_Description

prev_Service_User_Defined _10

prev_Service_User_Defined _11

prev_Service_User_Defined _12

prev_Service_User_Defined _18

prev_Service_User_Defined _19

prev_Service_User_Defined _2

prev_Service_User_Defined _20

prev_Service_User_Defined _21

prev_Service_User_Defined _3

prev_Service_User_Defined _4

prev_Service_User_Defined _5

prev_Service_User_Defined _6

prev_Service_User_Defined _7

prev_Service_User_Defined _8

prev_Service_User_Defined _9

prev_Service_User_Defined_1

prev_Skill_Level

prev_StartDateTime Previous Start Date/Time
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Value Additional Information

prev_State_Created

prev_State_Scheduled

prev_STRTTIME Previous Start Time
prev_SV_Tool_ID

prev_Task_Date

prev_Technician

prev_Technician_Long_Name

prev_Technician_Status

prev_TechnicianEmail TechnicianEmail comes from the SV00115.SV_Pager_PIN
column which can be used for the technician's SMS
email gateway email address. e.g. {phone-number}
@vtext.com” for Verizon as an example.

prev_TechnicianPhone

prev_TechnicianSkillLevel

prev_Time_Entered_CB Previous Time Entered checkbox
prev_Type_of_Call Previous Call Type
prev_Type_of_Problem Previous Problem Type
prev_UDCB1 Previous AC Notify flag
prev_UDCB2

prev_UPRTRXCD Previous Payroll Transaction Code

5 http://vtext.com
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Value Additional Information

prev_UserDD1

prev_UserDD2

prev_USERDEF1

prev_USERDEF2

prev_USRDATO1

prev_USRDAT02

prev_Wennsoft_Affiliate

prev_Wennsoft_Branch

prev_Wennsoft_Region

prev_WS_Cost_Code Previous Cost Code

prev_WS_Job_Number Previous Job Number

Setting up Technicians in Schedule

1. In Schedule, select the Menu === icon and then select Administration.
2. Select Resource Options.
3. Select the resource in the Resource list.
4. Enter the following information to integrate with Signature Agent Configuration:
« Technician Name (required): The technician name defaults into this field.
+ Position Description: The resource position defaults into this field.
« Phone: Enter the resource's telephone number.
« Email address: Enter the company email address(es) that the resource uses.
+ Notifications: Mark if the resource should receive notifications at the email address(es) provided.
« Inactive: Mark if the resource is currently inactive.
+ Select resource image: This image will display in the email that is sent to customers if you are

using Working with Advanced Communications (page 34).
5. Select Save.
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Modifying the Event Trigger Action Properties

Launch Signature Agent Configuration.

Select the Home tab.

Navigate to the company's Event Triggers.

Modify the Event Trigger Action Properties for the email action adding the new location properties
(Location_ADDRESS1, Location_CITY, Location_STATE, Location_ZIP).

Double-click on the Appointment-{appointment-event-name} event trigger.

Select the Actions tab.

Select the Email action and then select Ediit.

Right-click in the Subject and/or Email Body fields to select the new location properties to add.
Select Save.

N

W eNow

Enabling Additional Triggers in Microsoft SQL Server Management
Studio

» Enabling a Trigger in Microsoft SQL Server Management Studio (page 24)
+ Enabled Triggers Script (page 24)
» Disabled Triggers Script (page 26)

Enabling a Trigger in Microsoft SQL Server Management Studio

By enabling triggers that track changes are turned on or off for these tables. Most of these tables have a delete trigger
with a name in the format of ‘XXXX_D_CDC’ where XXXX is the table name and an insert/update trigger in the form of
‘XXXX_IU_CDC’. Two tables make an exception to this rule and have 3 triggers, one for Insert, one for update and one for
delete. They are tables SV00300 and SV00301.

To enable a trigger in Microsoft SQL Server Management Studio:

1. Launch Microsoft SQL Server Management Studio.

Expand Databases > your company database > Tables.

Expand the appropriate table.

Expand Triggers.

Right-click on the XXXX_D_CDC trigger and select Enable. (This is the "delete" trigger.)
Right-click on the XXXX_IU_CDC trigger and select Enable. (This is the "insert/update" trigger.)

oukrwN

Enabled Triggers Script

This script provides a list of all enabled scripts for a given company:
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SELECT sysobjects.name AS trigger_name, OBJECT_NAME (parent_obj) AS table_name,
OBJECTPROPERTY (id, 'ExecIsTriggerDisabled') AS [disabled]
FROM sysobjects
WHERE sysobjects.type = 'TR' AND sysobjects.name LIKE '%_CDC'
and OBJECTPROPERTY(id, 'ExecIsTriggerDisabled') = 0

ORDER BY disabled,sysobjects.name ASC

Enabled Triggers Query Results

These are the results of the enabled triggers script query, assuming all nine triggers are enabled. Note that the Entity
name does not display in the query results.

3114147 Table Name Trigger Name Disabled
Job JC00102 JC00102_D_CDC 0
JC00102_IU_CDC 0
Job Cost Code JC00701 JC00701_D_CDC 0
JC00701_IU_CDC 0
GP Customer RM00101 RM00101_D_CDC 0
RM00101_IU_CDC 0
Technician SV00115 SV00115_D_CDC 0
SV00115_IU_CDC 0
Service Option sv00196 sv00196_D_CDC 0
sv00196_IU_CDC 0
Location SV00200 SV00200_D_CDC 0
SV00200_IU_CDC 0
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114141 Table Name Trigger Name Disabled
Service Call SV00300 SV00300_D_CDC 0
SV00300_I_CDC 0
SV00300_U_CDC 0
Appointment SV00301 SV00301_D_CDC 0
SV00301_I_CDC 0
SV00301_U_CDC 0
Equipment SV00400 SV00400_D_CDC 0
SV00400_IU_CDC 0

Disabled Triggers Script

If you need to enable triggers for a table not found in this list, run the following script to find the triggers for a given
table not in the list and then go through Microsoft SQL Server Management Studio and manually enable the trigger:

SELECT sysobjects.name AS trigger_name, OBJECT_NAME (parent_obj) AS table_name,
OBJECTPROPERTY (id, 'ExecIsTriggerDisabled') AS [disabled]
FROM sysobjects

WHERE sysobjects.type = 'TR' AND (sysobjects.name LIKE '%_D_CDC' or
sysobjects.name LIKE '%_IU_CDC')

and OBJECTPROPERTY(id, 'ExecIsTriggerDisabled') =1

ORDER BY disabled,sysobjects.name ASC

Disabled Triggers Query Results
GP Database Level

These are the query results at the GP database level from the disabled triggers script. Note that the Entity name does
not display in the query results.
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114141 Table Name Trigger Name Disabled

Call Source SVCALSRC SVCALLSRC_D_CDC 1
SVCALLSRC_IU_CDC 1

GP Company SY01500 SY01500_D_CDC 1
SY01500_IU_CDC 1

Company Database Level

114147 Table Name Trigger Name Disabled
GP GL Account GL00100 GL00100_D_CDC 1
GL00100_IU_CDC 1
Job User Defined Jcooio7 JC00107_D_CDC 1
JC00107_IU_CDC 1
Estimate Revision JC00201 JC00201_D_CDC 1
JC00201_IU_CDC 1
Forecast Revision JC00401 JC00401_D_CDC 1
JC00401_IU_CDC 1
Job Cost Note JC00501 JC00501_D_CDC 1
JC00501_IU_CDC 1
Job Bill Code JC00601 JC00601_D_CDC 1
JC00601_IU_CDC 1
Job Revenue Code JC00610 JC00610_D_CDC 1
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Table Name Trigger Name Disabled
JC00610_IU_CDC 1
Employee Union Code JC00801 JC00801_D_CDC 1
Master
JC00801_IU_CDC 1
Change Order JC01001 JC01001_D_CDC 1
JC01001_lu_CDC 1
Change Order Cost Code JC01002 JC01002_D_CDC 1
JC01002_lU_CDC 1
Job Change Order JC01004 JC01004_D_CDC 1
Revenue Code
JC01004_1U_CDC 1
Job Vendor JC01501 JC01501_D_CDC 1
JC01501_IU_CDC 1
Job Vendor Date JC01504 JC01504_D_CDC 1
JC01504_IU_CDC 1
Job Project JC01701 JC01701_D_CDC 1
JC01701_lu_CDC 1
Rate Class JC01801 JC01801_D_CDC 1
JC01801_IU_CDC 1
Job Lien Waiver JC20705 JC20705_D_CDC 1
JC20705_1U_CDC 1
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Fed Class

Union Code

Cost Element

Resource Extension

GP Purchase Order

GP Purchase Order Detail

GP Address

GP Salesperson

Installation By

Time Zone
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Table Name

JC40106

JC40201

JC40209

K2A_ResourceExtension

POP10100

POP10110

RM00102

RM00301

SV_00415

SV00045

29

Trigger Name

JC40106_D_CDC

JC40106_IU_CDC

JC40201_D_CDC

JC40201_IU_CDC

JC40209_l1U_CDC

K2A_ResourceExtension_D_CDC

K2A_ResourceExtension_IU_CD
C

POP10100_D_CDC

POP10100_IU_CDC

POP10110_D_CDC

POP10110_IU_CDC

RM00102_D_CDC

RM00102_IU_CDC

RM00301_D_CDC

RM00301_IU_CDC

SV_00415_D_CDC

SV_00415_IU_CDC

SV00045_D_CDC

SV00045_1U_CDC



Signature Agent 2022 (2.5) - Working with Event Trigger Notifications

114141 Table Name Trigger Name Disabled
Division SV00077 SV00077_D_CDC 1
SV00077_IU_CDC 1
Note SV000805 SV000805_D_CDC 1
SV000805_IU_CDC 1
Customer SV00100 SV00100_D_CDC 1
SV00100_IU_CDC 1
Technician Vehicle SV00113 SV00113_D_CDC 1
SV00113_IU_CDC 1
Technician Branch SV00114 SV00114_D_CDC 1
SV00114_1U_CDC 1
Technician Skill Set SV00155 SV00155_D_CDC 1
SV00155_1U_CDC 1
Sublocation SV00201 Sv00201_D_CDC 1
SVv00201_IU_CDC 1
Problem Type SV00310 SV00310_D_CDC 1
SV00310_IU_CDC 1
Call Type SV00320 SV00320_D_CDC 1
SV00320_IU_CDC 1
Appointment Status SV00325 SV00325_D_CDC 1
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Table Name Trigger Name Disabled
SV00325_IU_CDC 1
Technician Activity sv00326 sv00326_D_CDC 1
sv00326_IU_CDC 1
User Define 1 SV00330 SV00330_D_CDC 1
SV00330_IU_CDC 1
User Define 2 SV00331 SV00331_D_CDC 1
SV00331_IU_CDC 1
Contract Equipment SV00403 SV00403_D_CDC 1
SV00403_IU_CDC 1
Equipment Type SV00405 SV00405_D_CDC 1
SV00405_IU_CDC 1
Manufacturer SV00410 SV00410_D_CDC 1
SV00410_IU_CDC 1
Model Number SV00411 SV00411_D_CDC 1
SV00411_IU_CDC 1
Extended Warranty Type SV00420 SV00420_D_CDC 1
SV00420_IU_CDC 1
Meter Reading SV00430 sv00430_D_CDC 1
sv00430_IU_CDC 1
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114141 Table Name Trigger Name Disabled
Contract SV00500 SV00500_D_CDC 1
SV00500_IU_CDC 1
Task Code SV00560 SV00560_D_CDC 1
SV00560_IU_CDC 1
Skill Level SV00572 SV00572_D_CDC 1
SV00572_1U_CDC 1
Invoice History SV00701 SV00701_D_CDC 1
SV00701_IU_CDC 1
Service Cost Code SV00735 SV00735_1U_CDC 1
Building SV01200 SV01200_D_CDC 1
SV01200_IU_CDC 1
Refrigerant Type SVv40180 SV40180_D_CDC 1
SV40180_IU_CDC 1
Refrigerant Code SV40182 SV40182_D_CDC 1
SV40182_1U_CDC 1
Refrigerant Leak SV40184 SV40184_D_CDC 1
SV40184_1U_CDC 1
GP Internet Address SY01200 SY01200_D_CDC 1
SY01200_IU_CDC 1
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114141 Table Name Trigger Name Disabled
GP Employee UPR00100 UPR00100_D_CDC 1
UPR00100_IU_CDC 1
GP Employee Tax Info UPR00300 UPR00300_D_CDC 1
UPR00300_IU_CDC 1
GP Employee Pay Code UPR00400 UPR00400_D_CDC 1
UPR00400_IU_CDC 1
GP Employee State Tax UPRO0700 UPR0O0700_D_CDC 1
UPR00700_IU_CDC 1
GP Department UPR40300 UPR40300_D_CDC 1
UPR40300_IU_CDC 1
GP Position UPR40301 UPR40301_D_CDC 1
UPR40301_IU_CDC 1
GP Pay Code UPR40600 UPR40600_D_CDC 1
UPR40600_IU_CDC 1
GP Workers Comp UPR40700 UPR40700_D_CDC 1
UPR40700_IU_CDC 1
GP Payroll State UPR41100 UPR41100_D_CDC 1
UPR41100_IU_CDC 1
Purchase Order Detail WS10101 WS10101_D_CDC 1
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Table Name Trigger Name Disabled
WS10101_IU_CDC 1
TimeTrack Option WS40000 WS40000_D_CDC 1
WS40000_IU_CDC 1
TimeTrack Registered WS41001 WS41001_D_CDC 1
User
WS41001_IU_CDC 1
Attachment WSDOCS WSDOCS_D_CDC 1
WSDOCS_IU_CDC 1

Restoring Default Triggers

You can restore a company's default standard triggers from the Home view.

€© WARNING

This removes ALL of the company's trigger configurations and any new triggers you may have created. This
includes all standard and advanced communication triggers.

To restore the default standard triggers:

1. Launch Signature Agent Configuration.

Select the Home tab.

Expand Tenant and select the company name.

From the top navigation, select Restore Default Triggers.

You may receive up to two confirmation windows, one for standard triggers and one for advanced
communications triggers. In each confirmation window, select OK.

aorwDn

Working with Advanced Communications

Advanced Communications is an add-on product that provides you with the ability to send the following appointment
trigger emails to your customers from within Schedule. You can send the advanced HTML email notification in Schedule

from the appointment window by selecting Notify Customer @ or by right-clicking the appointment and then
choosing Notify Customer.

& fthe Advanced Comm Triggers tab is not displayed, contact WennSoft Support.
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In addition to the default standard triggers (page 0), Advanced Communications provides you the ability to notify the
customer and/or technician when the following appointment triggers occur:

Trigger AC_Notify Default Notification
Appointment Canceled 1 Notify Button
Appointment Changed 1 Notify Button
Appointment Completed 0 Automatic
Appointment Scheduled 1 Notify Button
Request Received 0 Automatic
Technician Arrived 0 Automatic
Technician In Route 0 Automatic

Advanced Communications is set up within two applications:

+ Signature Agent Configuration contains the company information including the logos and accent color for the

HTML email. For setup information, see Completing Signature Agent Configuration (page 5).

» Schedule contains the technician information including the technician's position, email address, and photo that
is included in the HTML email. For more information, see Setting up Technicians in Schedule (page 23).

Viewing and Editing Advanced Comm Triggers

& Because the templates for Advanced Communications are prepopulated and cannot be edited, the Actions tab
is not enabled in the Edit Event window. To see samples of the email templates, see Sample Advanced

Communication Email Notifications (page 37).

Viewing a Trigger's Properties

To view the properties for a trigger, select the trigger and the operations and trigger criteria display at the bottom of the
window.
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Enabling a Trigger

3.

To edit the trigger properties, select an event trigger and then select Properties.

In the Edit Event window, the General tab displays the General Settings and Operations. For Advanced
Communication triggers, these fields are display-only and cannot be edited, except for the Trigger Enabled
checkbox.

« Trigger Name: Indicates that any time a service call is created, this event will be active.

« Trigger Type: Displays a list of active CDC tables.

« Event ID: Displays the name of the Event ID.

« Operations: Indicates that any time something deleted, inserted, and/or updated in the CDC table view,
the trigger will activate. Depending on the trigger type, additional choices are available in the Operations
section.

« The Trigger Enabled checkbox indicates that the trigger is in use.

Select OK.

Editing Trigger Criteria

The Trigger Criteria tab is used to set up specific criteria that may need to be met for the trigger to activate.

& When using a DATE field, the parameters must be encompassed between hash marks #.

For example: [CREATDDT] > #2022-01-26 00:00:004.

To edit the trigger properties:

1.
2.
3.

Select an event trigger and then select Properties.

Select the Trigger Criteria tab.

Use the Values and Previous Values tabs and the formula buttons to create the trigger criteria. To enter the
values necessary for the formulas, select the VAL button and enter the data.

If you want to have your triggers automatically send notifications to your customers and technicians, you can
edit the AC_Notify criteria value to 0. When the AC_Notify criteria is set to 1, the Notify button in Schedule needs
to be selected to send the notification.

36



Signature Agent 2022 (2.5) - Working with Advanced Communications

Edit Event

General

([prev_state_created] = 1 or [prev_state_scheduled] I= 1) and [state_scheduled] = 1 and
[Appointment_Type] =1

and

[AC_Notify] =1

Trigger Criteria

+ -1 *|f == =||= (n) AND OR | |DATE| | VAL

Values | Previous Values

Actual_Hours -
ADRSCODE

Appointment

Appointment_Description

Appointment_Group_ID

Appointment_Priority

Appointment_Status

Appointment_Type

Caller Email Address ~

0K Cancel

5. Select OK.

Sample Advanced Communication Email Notifications

The following are examples of the Advanced Communication email templates:

« Appointment Cancelled
+ Appointment Changed
« Appointment Complete
« Appointment Scheduled
« Request Received

+ Technician In Route

+ Technician Arrived
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Appointment Cancelled

)

=
=
@©
2

4

The request for service at ACCURATE-12500 CLEVELAND AVE has been cancelled.

If this request has been cancelled in error, please contact Fabrikam, Inc. at (312) 436-2671 to
reschedule this request

APPOINTMENT INFO

SERVICE CALL NUMBER
210422-0003:0001

CUSTOMER
ACCURATE PRINTING

LOCATION
ACCURATE-12500 CLEVELAND AVE

REQUESTOR
Dan Balsbaugh

REQUEST
NOTIFY TEST
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Appointment Changed

72
L

a,
1x
=)

Andrew Seltzer
Master Technician

Your appointment at ACCURATE-12500 CLEVELAND AVE has been changed and is scheduled
for Thursday, April 22, 2021 at 4:00 PM. Your appointment information and technician contact
information can be found below.

To reschedule or cancel your appointment, please contact Fabrikam, Inc. at (312) 436-2671 .

APPOINTMENT INFO TECHNICIAN INFO
SERVICE CALL NUMBER NAME
210422-0003:0001 Andrew Seltzer
CUSTOMER
ACCURATE PRINTING CELL
2622993344
LOCATION
ACCURATE-12500 CLEVELAND AVE EMAIL
dbalsbaugh@key2act.com
REQUESTOR

Dan Balsbaugh

REQUEST
NOTIFY TEST
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Appointment Complete

Andrew Seltzer

Master Technician

The work associated with your request at ACCURATE-12500 CLEVELAND AVE is now

complete.

For additional infermation about your appointment, please contact Fabrikam, Inc. at (312) 436-

2671 .
SERVICE CALL NUMBER NAME
210422-0002:0001 Andrew Seltzer
CUSTOMER
ACCURATE PRINTING CELL
2622993344
LOCATION
ACCURATE-12500 CLEVELAND AVE EMAIL
dbalsbaugh@key2act.com
REQUESTOR

Dan Balshaugh

REQUEST
ADVCOMM TEST 2
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Appointment Scheduled

it
N

@
£
j o)

Andrew Seltzer

Master Technician

An appointment has been scheduled at ACCURATE-12500 CLEVELAND AVE for Thursday,
April 22, 2021 at 4:00 PM. Your appointment information and technician contact information can
be found below.

To reschedule or cancel your appointment, please contact Fabrikam, Inc. at (312) 436-2671 .

APPOINTMENT INFO TECHNICIAN INFO
SERVICE CALL NUMBER NAME
210422-0004:0002 Andrew Seltzer
CUSTOMER
ACCURATE PRINTING CELL
2622993344
LOCATION
ACCURATE-12500 CLEVELAND AVE EMAIL
dbalsbaugh@key2act.com
REQUESTOR
Dan Balsbaugh
REQUEST

SCHEDULED TEST




Signature Agent 2022 (2.5) - Working with Advanced Communications

Request Received
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A request for service has been received for ACCURATE-12500 CLEVELAND AVE.

If this request has been made in error or is no longer required, please contact Fabrikam, Inc. at
(312) 436-2671 to cancel this request.

APPOINTMENT INFO

SERVICE CALL NUMBER
000101-0003:0001

CUSTOMER
ACCURATE PRINTING

LOCATION
ACCURATE-12500 CLEVELAND AVE

REQUESTOR
dbalsbaugh@KEY2ACT.COM

REQUEST
This is my service request test service call
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Andrew Seltzer
Master Technician

The technician handling this appointment has been dispatched to ACCURATE-12500
CLEVELAND AVE and is scheduled fo arrive at 3:00 PM. Your appointment information and
technician contact information can be found below.

For additional information about your appointment, please contact Fabrikam, Inc. at (312) 436-

2671 .

APPOINTMENT INFO

SERVICE CALL NUMBER
210422-0003:0001

CUSTOMER
ACCURATE PRINTING

LOCATION
ACCURATE-12500 CLEVELAND AVE

REQUESTOR
Dan Balsbaugh

REQUEST
NOTIFY TEST

TECHNICIAN INFO

NAME
Andrew Seltzer

CELL
2622993344

EMAIL
dbalsbaugh@key2act.com
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Technician Arrived

Andrew Seltzer

Master Technician

The technician handling your appointment has arrived at ACCURATE-12500 CLEVELAND AVE
and is about to begin working on your request.

For additional information about your appointment, please contact Fabrikam, Inc. at (312) 436-

2671.
APPOINTMENT INFO TECHNICIAN INFO
SERVICE CALL NUMBER NAME
210422-0003:0001 Andrew Seltzer
CUSTOMER
ACCURATE PRINTING CELL
2622993344
LOCATION
ACCURATE-12500 CLEVELAND AVE EMAIL
dbalsbaugh@key2act.com
REQUESTOR

Dan Balsbaugh

REQUEST
NOTIFY TEST
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Sending Email Requests to Create a Service Call

Your customer can send an email that is sent to the accesskey@act.key2act.io® email address OR to an email address
that our user has set up (service@company.com’) that forwards the email to the access key email address.

In Outlook the body text can be added to a Quick Part template gallery to quickly insert the information into a new
email. The customer would then only have to enter a subject line and the description after inserting the Quick Part. See

Working with Quick Part Templates (page 46) below.

1. Your customer opens their email program and opens a new message.
2. The customer enters the:
+ Email Address
« Email Subject
« Email body that follows the template as determined by the user in the Event Trigger Properties.
3. The following lines including the colon ":" in the body of the email are required to generate a service email.
Additional fields may be added, like "Equipment ID:".
« Customer Number: <Actual customer number in Signature>
+ Location Number: <Actual location ID in Signature>

« Description: <Used in service call description>

Example Email

Example of an email with the optional line for Equipment ID:

Untitled - Message (HTML)

File Message Insert Options Format Text Review Developer Help  Acrobat Q Tell me what you want to do
milallE el R0 S & = I
Um e ¥

Paste Basic | Names | Include Tags Dictate | Sensitivity Save to Insights | Add from MNew View

w & | Textv e e A @ Evernote SharePoint | Meeting Poll | Templates
Clipboard R Voice Sensitivity Evernote harmen.ie FindTime My Templates ~
E To accesskey@actkey2actio
Send Cc
Subject Enter any subjecﬂ

Customer Number: <customer ID>
Location Number: <location ID>
Description: <enter text>
Equipment ID: <equipment |D>

6 http://act.key2act.io
7 http://company.com
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Working with Microsoft Outlook Quick Part Templates

Adding a Quick Part Template in Microsoft Outlook
If you are using Microsoft Outlook email, you can have your customers create a Quick Part.

1. Open anew message window (as if to send a new email).

2. Type and then select the text to be added as a Quick Part.

3. OntheInsert tab, locate the Text section. (The Insert tab is only visible in a new email. The Text section is only
enabled if you click in the body of the new email.)

Enter any subject - Message (HTML)

File Message Insert Options Format Text  Review Developer Help  Acrobat @ Tell me what you want to do
@J Eh B - r(')ShapesV B @ Link ~ E]Te)ct Box EDrop Cap v
b= Q Q
e ! fg Icons |:[|] D Bookmark Quick Parts ~ @ Date & Time
Attach Outlock Table Reuse Pictures . Symbols
I — > Files v (D 3DModels v [l A WordArt~ B Object v
Include Tables |Reuse Files lllustrations Links Text ~
Explore Quick Parts
P To accesskey@act.key2actio Insert preformatted text, auto-text,
document properties, and fields
Send Cc anywhere in the document.
. To reuse content in your document,
Subject Enter any subject select it and save it to the Quick
Part Gallery.
Customer Number: <customer ID> @ Tell me more
Location Number: <location ID>
Description: <enter text>
Equipment ID: <equipment ID>
4 »

4. Select Quick Parts.

5. Select Save Selection to Quick Part Gallery...

6. Inthe Create New Building Block window, you can name the Quick Part and enter a description.
« Name: Enter a descriptive name.
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« Description: Enter a brief description.

Create New Building Block

MName: Service Call Request Template
Gallery: Quick Parts b
Category: General b

Use this template to create a service call
Description:  |request.

Save in: NaormalEmail.dotm b

Options: Insert content anly b

o [ one

7. Select OK.

Using a Quick Part Template

1. Open a new message window (as if to send a new email).
2. Onthe Insert tab, locate the Text section.
3. Select Quick Parts.
4. Select the appropriate template.
5. The body of the email is populated with the text.
6. Editthe text as needed.
Enter any subject - Message (HTML)
File Message Insert Options Format Text Review Developer Help  Acrobat @ Tell me what you want to do
R=ERl= N el S
Attach Outlook Table Reez | o 2 - corma S ghae&Time | qmbols
File~  Item v Files v 3D Models v i~ General
Include Tables [Reuse Files lllustrations Links Service Call Request Template

|Customer Number: <customer ID>

- Location Number: <location 10>
To accesskey@act.keylactio Description: <enter text>

B Equipment ID: <equipment ID>

Send Cc
Subject Enter any subject
#n AutoText >
Customer Number: <customer 1D> Save Selection to Quick Part Gallery...
Location Number: <location D>
Description: <enter text>
Equipment ID: <equipment 1D>
4 »
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Flow Examples

« Simple Email (page 48)
« Email with Attachment (page 48)
« Customer Calls for Service and Wants Notifications (page 50

Simple Email

Depending on the recipient configuration in the Event Trigger Properties, the following may occur:

<>

Customer
sends email.

Customer receives an email that the
service call has been oreated.

Customer receives email that the

appointment has been scheduled.
(Caller email address
added to Service Call.)

Tech receives notification the
appointment has been scheduled.
[Tech email address
entered in Schedula)

Email with Attachment

In addition to the email, the customer may attach a file to the email message. For example, a picture of the
malfunctioning equipment.
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Customer sends a
service request
email with an
attachment.
Unassigned service call request comes Cus tomer receives email that the
into the Dispatch Board, Schedule, G5B. appointment has been scheduled.
(Caller email address
Service @ ll attachment can beviewed added to Service Call.)

v

Customer receives email that
appointment has been scheduled

Technician receives message that
appointment has been scheduled.

Customer receives email that the
appointment has been rescheduled.

Technician receives email that the
appointment has been rescheduled.
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Customer Calls for Service and Wants Notifications

«=»

Customer calls for
senvice reguest,

v

Service @ll created
in Service Manager.

v

Caller email address
added to Service
Call.

Dispatcher Tech receives notification the
schedules appointment has be-en scheduled.
; [Tech email address
appointment. enterad in Schedule)

«»

Customer receives email that the
appointment has been scheduled.
[Caller email address
entered on Service Call)

Accessing the Signature Status Page

The Signature Status page includes the following Signature Agent Application Service status information.

« Agraph displays the uptime status for the past 90 days. The uptime percentage is displayed beneath the graph.

« Acalendar view of the uptime by selecting View historical uptime.
+ Previous incidents are listed by date below the status graph section.
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@) Signature

All Systems Operational

View historical uptime.

Operationa

Signature Agent Application Service 7

Past Incidents

Apr 29,2021

Access the Signature Status Page

1. In Signature Agent, select About.

Select Signature Status to open a browser to https://signature.statuspage.io/.

3. Select the Subscribe to Updates button to receive notifications whenever the Status Page has new, updated, or
resolved incidents. After you subscribed, you'll receive a notification that asks you to confirm your subscription.
You can receive updates in one or more of the following methods: email, text message, webhook, and/or RSS
feed. You can also access the WennSoft Customer Support Center.

N

Uninstalling Signature Agent Configuration

Uninstall the Agent Service
Prior to uninstalling Signature Agent, you will need to uninstall the Agent Service.

1. Launch Signature Agent Configuration.
2. From the button bar, select Uninstall Service.
3. Select OK in the Success pop-up window.
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Uninstall Signature Agent Configuration

To permanently remove Signature Agent Configuration, you will need to uninstall Signature Agent from the Microsoft
Add/Remove Programs window.
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Contact Information

Support

Phone: 262-317-3800
Email: support@wennsoft.com®

Hours: Normal support hours are 7:00 a.m. to 6:00 p.m. Central Time. After-hours and weekend support is available for
an additional charge. Please contact WennSoft Support for additional information.

WennSoft will be closed in observance of the following holidays: New Year's Day, Memorial Day, Juneteenth,
Independence Day, Labor Day, Veteran's Day, Thanksgiving Day, the day after Thanksgiving, Christmas Day, and the day
after Christmas.

Support Plans
We're committed to providing the service you need to solve your problems and help your team maximize productivity.

We offer several Signature Enhancement and Support Plans to meet your needs and Extended Support Plans for retired
product versions available at https://www.wennsoft.com/wsportal®.

Sales

Phone: 262-317-3700
Fax: 262-317-3701

WennSoft Headquarters

Address:

WennSoft

1970 S. Calhoun Rd.

New Berlin, WI 53151-1187

Phone: 262-821-4100 or 866-539-2228

Email: info@wennsoft.com*?

Website: www.wennsoft.com™!

Office hours: Monday through Friday from 8 a.m. to 5 p.m. Central Time.

8 mailto:support@wennsoft.com

9 https://www.wennsoft.com/wsportal/
10 mailto:info@wennsoft.com

11 http://www.wennsoft.com
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